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Summary

A review of Full-Potential (FP) Methods is given. FP methods are then

analysed in terms of their place in the hierarchy of models available to

compute transonic flows. Subsequent sections detail a particular approach

to solving the FP equation, making use of unstructured grids and mod-

ern numerical methods. Results of this approach are compared with Euler

solutions for aerofoils.
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Chapter 1

Introduction

The advent of modern CFD came with the possibility of solving non-linear

transonic flow equations. The availability of digital computers in the 1960’s,

made it increasingly possible to tackle non-linear flow problems. The par-

ticular characteristics of transonic flow physics made obtaining insight into

transonic flow aerodynamics extremely difficult by analytical methods. The

Euler equations describe the most important aspects of transonic flows,

however the computational resources in the early 1970’s were not available

yet to solve the Euler equations. Potential methods can describe the non-

linearities of transonic flows, by solving one single equation. For similar

computational grids, it is expected that a FP code is an order of magni-

tude faster than solving the Euler equations. This simplicity comes at a

modelling cost, that will be explained in the next sections.

Solving transonic flow problems became the focus of many researchers

during the 1970’s. The numerical difficulties associated with the Full-

Potential and Transonic Small Disturbances (TSD) equations stem from

the changing nature of the partial differential equations (PDE). When the

flow is subsonic, the PDE’s are elliptic in nature; however, in supersonic

regions the equations are hyperbolic. The breakthrough numerical meth-

ods was made by Murman and Cole [33]. Murman and Cole applied their

algorithm to the TSD equation, that switched from a central differencing

scheme within the subsonic regions to an upwind scheme in regions of super-

sonic flow, according to the local Mach number. From this point onwards,

a variety of methods were proposed to improve efficiency and the range of

applicability of FP methods. Notably, the successive overrelaxation (SOR)
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introduced by Steger and Lomax [41], was applied to 2D aerofoils. An im-

provement over SOR methods was introduced by the use of approximation

factorisation (AF) methods [4]. Ballhaus and Bailey [5], and Bailey and

Steger [3] solved the TSD equation over wings, using AF algorithms.

AF algorithms with multi-grid formulations, were substantially improved,

over the following decades and are still the formulation used in current codes

for aeroelastic analysis, e.g. CAP-TSD [6,13] and the ASP3D [7].

Another successful method was introduced by Caughey and Jameson

[26]. Unlike the previous methods, that used finite difference schemes, the

authors applied a finite-volume formulation. To stabilise the scheme when

in the presence of supersonic flow, artificial viscosity was introduced, to

give the scheme an upwind bias. This methodology was based of the widely

used and successful codes of the FLO series, developed by Jameson and

co-workers [27].

Although improvements over the last 30 years, in both algorithms and

computational power have been continuous and impressive, FP methods

still have a place in the toolbox of the aerodynamicist. Solution of the

Euler and Reynolds Average Navier-Stokes (RANS) equations are obtained

routinely nowadays. Nevertheless, 3D complex geometries, unsteady aero-

dynamic problems, fluid/structures (CFD/CSD) interaction, design optimi-

sation problems still require significant computational resources. For these

types of situations FP methods are very competitive, as long as the problem

is within the region of validity of the physical model. The limitations of FP

methods result from assumptions when formulating the FP or TSD equa-

tion: an inviscid, isentropic and irrotational flow is assumed. This limits

the applicability of the method up to low supersonic Mach numbers, typi-

cal freestream Mach numbers of 1.3 [24]. Since most aircraft (military and

civil) have high subsonic cruising velocities, FP methods can provide very

accurate resultsat low computational cost, for most cruise conditions.

Therefore, it is logical to apply TSD/FP methods to computationally

demanding problems, such as the ones found in aeroelasticity. Good ex-

amples of continuous development in the capability of this approach in the

field of aeroelasticity is illustrated by the evolution of several computer

codes: TRANAIR [29], CAP-TSD [23], ASP3D [7]. The CAP-TSD code

has been used extensively for predicting aeroelastic phenomenon such as
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flutter and has been applied to several complex configurations, including

full aircraft configurations, [9, 11, 28]. The ASP3D is a recent example of a

new code being developed based on the TSD equation. This latest exam-

ple improves on several shortcomings on the previous generation CAP-TSD,

namely entropy, vorticity effects and viscous-inviscid capability. Initial vali-

dation studies have been performed for several transonic flows, ranging from

2D aerofoils to typical fighter configurations.

Hierarchy of Models for Transonic Aerodynamics

Figure 1.1 illustrates some of the most common methods available in Com-

putational Aerodynamics. Several of the methods mentioned, such as DNS,

are still well beyond the required resources in order for them to be use

in engineering problems. URANS calculations have been used in several

problems relevant to aeroelasticity, e.g. rotors, flutter, LCO, [10, 15]. Ap-

plying URANS to complete aircraft configurations still requires significant

resources, as shown in table 1.1; Euler simulations are still the main tool to

model the aeroelastics of complex configurations at transonic conditions. A

lower level of approximation for compressible aerodynamics is to use the full

potential and transonic small-disturbance equations. These equations, re-

spectively, are the lowest level of approximation to non-linear compressible

flows. In the interest of exploring the computational cost, each level of ap-

proximation has been further developed and its range of validity extended.

A good example is given by Mavriplis [30] for the DLR-F4 model, where

coupling Euler and Boundary Layer equations greatly improved the results

for the wing-body configuration at transonic conditions; the coupling yields

signifficant improvement in shock location and strength, as shown in figures

1.2 - 1.3, at a marginal increased in computational costs.

An interesting comparison between types of models was performed by

Bennet and Edwards [10] and by Eastep et al [15]. Both groups of au-

thors investigated an aeroelastic problem with the CAP-TSD code and the

Euler/Navier-Stokes codes, ENS3DAE and the CFL3D-Euler code. The re-

sults of this work show a close relation in the majority of cases between all

models; a few results indicated strong influence of viscous effects, mainly

at supersonic speeds, while the second test wing was more susceptible to
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Figure 1.1: Hierarchy of Models for Transonic Aerodynamics

viscous effects before the flutter dip; laminar-turbulent transition location

could increase the flutter speed by up to 10%. Eastep et al investigated con-

trol surface reversal at transonic conditions, here the model tested showed

larger differences between the solutions computed using TSD and Euler

methods, in fact the inclusion of viscous effects into the TSD scheme did

not yield any improvement to the solution in this particular case. The au-

thors also compared the computation times required for several methods,

shown here in table 1. It was concluded that the results indicate that, for

Model Grid Size MG Cycles to
Convergence

Normalised Run
Time

Euler 105 − 106 50 − 100 1.0
Euler + IBL 105 − 106 100 − 300 2 − 3

RANS 106 − 107 250 − 1000 50 − 100
DES 107 − 108 5000 − 10000 5000 − 10000
LES 109 − 1010 O(106) O(108)

Table 1.1: Physical Model Requirements (Unstructured grids), [30]
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(a) (b)

Figure 1.2: a) Euler Simulation; b) RANS Simulation, [30]

(a) (b)

Figure 1.3: a) Euler+IBL Simulation; b) RANS Simulations, [30]

preliminary design, inviscid calculations provide suitable, although conser-

vative, solutions.
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Aerodynamic Method Time
Linear (surface panels) 0.1

Inviscid linear (CAP-TSD) 1.0
Inviscid non-linear (CAP-TSD) 1.2
Viscous non-linear (CAP-TSDV) 20

Inviscid non-linear (Euler) 20
Viscous non-linear (N.S.) 50

Table 1.2: CPU time based on a single workstation, from ref. [15]
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Chapter 2

Theory

The derivation of the Full-Potential equation is well documented in the

literature, [24, 31], and can have several different formulations. The main

differences are concerned with the use of a conservative or non-conservative

scheme. In this work a conservative formulation is adopted, the reader is

pointed towards reference [24] for details of alternative formulations. A brief

overview of the derivation of the FP equation is given next.

2.1 Flow Equation

The development of any FP method, starts with the velocity potential. This

potential exists if it is assumed the flowfield is irrotational [24]:

∇× q = 0 (2.1)

An exact velocity potential function can then be defined as:

∇φ = q (2.2)

In Cartesian coordinates this is equivalent to:

∇φ = q = ui + vj + wk =>















φx = u

φy = v

φz = w

(2.3)
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2.1 Flow Equation

The Full Potential equation can be derived from the continuity equation:

∂ρ

∂t
+

∂

∂xi

(

ρq
)

= 0 (2.4)

From eq.2.3, the continuity equation, eq.2.4, can be written as:

∂ρ

∂t
+ ∇ · ρ∇φ = 0 (2.5)

Eq.2.5 still has two unknowns, φ and ρ, therefore to close the system it is

necessary to obtain a relationship between the density and potential func-

tion. One way of doing this difficulty is by using Crocco’s unsteady equation:

T∇s + q × Ω = ∇h0 +
∂q

∂t
(2.6)

where:

• s - entropy

• Ω - vorticity

• h - enthalpy

• h0 - stagnation enthalpy

Assuming irrotational (Ω = 0) and isentropic (s=constant) flow, and ap-

plying eq. 2.2 and eq.2.3 the potential function can be defined as:

∂φ

∂t
= −h0 = −

[

h +
1

2
(u2 + v2 + w2)

]

(2.7)

As well as isentropic, the working fluid in this work is air and it is assumed

that it behaves as a perfect gas. Hence the following relations for pressure

and density are also valid:

p

p∞
=

(

ρ

ρ∞

)γ

(2.8)

p = ρRT (2.9)
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2.2 Boundary Conditions

By combining eq.2.3, 2.7-2.9 a relationship between the density and poten-

tial function derivatives (i.e. velocity components) is obtained:

ρ

ρ∞

=

[

1 +
γ − 1

2
M2

∞

(

1 − φt − φx − φy − φz

)

]
1

γ−1

(2.10)

2.2 Boundary Conditions

For aerodynamic applications, it is necessary to specify the flow condi-

tions at the outer boundaries and solid surfaces. For the outer boundaries,

freestream conditions are assumed. This makes the task of calculating the

potential function at the farfield straightforward:

φ∞ = q∞ · −→r (2.11)

where:

• q∞ - is the freestream velocity

• −→r - is the position vector of the outer boundary point

For the solid surfaces a flow tangency condition is imposed, i.e. the

normal velocity to the surface is 0. This condition is given by:

ρq∞ · n = ρ
∂φ

∂n
= 0 (2.12)

2.3 Kutta Condition and Circulation

In order for the FP methods to be applied in aerodynamics, they should be

able to predict aerodynamic loads, i.e. lift, drag, moments. Following the

Kutta-Joukowski theorem, lift is proportional to circulation:

L = ρ∞q∞Γ (2.13)

where Γ represents the circulation. For a typical aerofoil section, the circu-

lation is defined as:

Γ =

∮

l

q dl (2.14)

CFD Lab - Uni. of Liverpool 10



2.4 Numeric Stabilising Schemes

According to Stokes theorem, the circulation is related to the vorticity by:

Γ =

∮

l

q dl =

∫

S

∇× q · ~n dS (2.15)

From assumptions given by eq.2.1, i.e. vorticity is zero, potential flows

can not produce circulation, and therefore lift. To overcome this, a point

vortex is added and its contribution is added to the non linear potential

function.The outer boundary freestream conditions are modified according

to:

φob = φ∞ + φvo (2.16)

where:

φvo =
Γ

2π
θ (2.17)

The vortex potential function, φvo, is a function of the circulation and θ is

the angle formed by the outer boundary location and the wake cut (positive

in the anti-clockwise direction), as illustrated by figure 2.1 . Note that θ

is double-valued at 0 and 2π. This corresponds to a jump in the velocity

potential from the value at θ = 0 to when θ = 2π, across the wake cut.

The magnitude of the velocity jump is determined by the Kutta condition.

The Kutta condition calculates Γ and the components of velocity normal to

the wake in such a way that forces the airfoil trailing edge upper and lower

pressures to match. This correction is then applied along the cut, until

the outer boundary. To calculate the Γ at the trailing edge, it is necessary

to calculate the potential function contributions from the upper and lower

sides, Γ is then given by:

Γ = φu,te − φl,te (2.18)

2.4 Numeric Stabilising Schemes

Type Depending Differencing

As mentioned before, transonic flow equations require an adaptive algorithm

to account for the changing nature of the flow equations, when the flow is
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2.4 Numeric Stabilising Schemes

Figure 2.1: Vortex Potential Function

subsonic or supersonic. The first scheme to incorporate such ability [33],

makes use of a simple switch to change between a central differencing scheme

and an upwind one. Murman and Cole modified the fluxes according to the

formula:

f i+1/2,j = µifi+1/2,j + (1 − µi)fi−1/2,j (2.19)

and µ is defined according to:

µi =







0, Mi,j > 1

1, Mi,j ≤ 1
(2.20)

Artificial Viscosity

An alternative to this method was proposed by Caughey and Jameson [26].

Here, the authors introduced viscosity explicitly into the system. This arti-

ficial viscosity modifies the potential equation by introducing extra terms.

Eq. 2.5 can be expressed as:

∂

∂x
(ρφx) +

∂

∂y
(ρφy) +

∂

∂z
(ρφz) = 0 (2.21)

CFD Lab - Uni. of Liverpool 12



2.4 Numeric Stabilising Schemes

this is modified by adding the artificial viscosity terms, P , Q and R:

∂

∂x
(ρφx + P ) +

∂

∂y
(ρφy + Q) +

∂

∂z
(ρφz + R) = 0 (2.22)

P̂ = µ
ρ

a2

(

u2δxx + uvµxyδxy + uwµxzδxz

)

φ (2.23)

Q̂ = µ
ρ

a2

(

uvµxyδxy + v2δyy + vwµyzδyz

)

φ (2.24)

R̂ = µ
ρ

a2

(

uwµxzδxz + vwµyzδyz + w2δzz

)

φ (2.25)

where a is the speed of sound and µ is the switching function, given by:

µ = max

[

0,

(

1 −
a2

q2

)]

(2.26)

The final component is given by, for example:

P =







P̂i,j,k, u > 0

P̂i+1,j,k, u < 0
(2.27)

Artificial Density

A similar, widely used approach, consists of modifying the density for-

mula, [14, 19, 22]. The FP equation, eq.2.28 is modified according to:

∂

∂x
(ρ̃φx) +

∂

∂y
(ρ̃φy) +

∂

∂z
(ρ̃φz) = 0 (2.28)

ρ̃ = ρ −
µ

q

[

uρx∆x + vρy∆y + wρz∆z
]

(2.29)

In this technique the density is calculated at the cell interface; the density

gradient (ρx, ρy, ρz) is calculated at the upwind cell centre and the values

∆x, ∆y, ∆z, are twice the distance from the cell interface to the upwind

cell centre. The switch, µ is defined by:

µ = max

[

0,

(

1 −
M2

c

M2

)]

CM2 (2.30)

where M is the local Mach number, Mc is a cut off Mach number (typical

0.95), C is an adjustable constant between the values of 1 and 2.

CFD Lab - Uni. of Liverpool 13



2.4 Numeric Stabilising Schemes

Flux Upwind Schemes

One drawback of the Murman and Cole schemes, is that it allows entropy

violating expansion shocks. This led researchers to look for procedures that

would eliminate non-physical solutions shocks. Engquist and Osher [37]

developed such a scheme, their work was further generalised by Osher et

al. [38] who compared their scheme with Godunov flux upwinding methods.

Following ref. [24], the two flux upwinding schemes, for a 1D equation, can

be described as:

(ρφx)x
∼=

1

∆x

[

(ρu)i+1/2 − (ρu)i−1/2

]

(2.31)

where

(ρu)i+1/2 = ρ∗u∗ − max
[

∆+

i−1/2
, ∆−

i+1/2

]

, Godunov (2.32)

(ρu)i+1/2 = ρ∗u∗ − ∆+

i−1/2
− ∆−

i+1/2
, Engquist-Osher (2.33)

∆+

i−1/2
=







ρ∗u∗ − (ρu)i−1/2, if ui−1/2 > u∗

0, if ui−1/2 < u∗
(2.34)

∆−
i+1/2

=







0, if ui+1/2 > u∗

ρ∗u∗ − (ρu)i+1/2, if ui+1/2 < u∗
(2.35)

In this procedure the variables ρ∗ and u∗ represent the values at sonic con-

ditions. The overbar refers to upwind terms. Comparisons between flux up-

wind schemes and the previous schemes mentioned can be found in refs. [18]

and [42]. Overall the authors conclude that the differences between the al-

gorithms are minimal.
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Chapter 3

Numerical Algorithm

3.1 Spatial Discritisation

Several methods were developed over the years to numerically solve equa-

tions like eq.2.4 and eq.2.5. The approaches found in the CFD litera-

ture, [1, 12, 17, 21], are finite-differences, finite-volumes and finite-element

methods. The aim of this particular work, is to develop a fast analysis

method for complex configurations. A key task is the necessity to generate

computational grids to discretise the flow domain. Taken into consideration

the time required to generate computational grids for complex geometries,

an unstructured finite volume approach was preferred.

It is now necessary to discretise eq.2.5 in space. This is followed by a sec-

ond step, where the equations are integrated in time. A finite-volume spatial

discretisation is applied to the domain Ω, which is divided into a finite num-

ber of non-overlapping sub-domains or control volumes. The finite-volume

method allows certain choices for the control-volumes of a given compu-

tational grid. If the grid cells coincide with the control volumes and the

variables are stored at the cell centres, the scheme is called cell-centred (as

is the case here); another possibility is to use a dual grid and store the

variables at the grid nodes, this is known as cell-vertex scheme. The full

potential equation, eq.2.5, is applied to each individual control volume k.

For steady state cases the following equation for mass conservation can be

written:
∮

Sk

ρ∇φ · ~nk ds = 0 (3.1)
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3.2 Flux Calculation

where Ωk refers to control-volume k, Sk is the sub-domain boundary and

~nk is the unit outward normal at the boundary. For each control-volume k,

eq.3.1 can be approximated by:

m−faces
∑

j=1

(

ρ∇φ · ~nj

)

∆Aj = Rk = 0 (3.2)

where Rk represents the residual of a particular cell.

3.2 Flux Calculation

In order to compute the residual, eq.3.2, the flux on each cell face has to be

calculated. For the potential function the flux consists of the density and

velocity; both these terms are a function of φ only. Eq. 2.10 defines the

density, therefore this can be calculated at any face, once the velocity vector

is obtained. This leaves the calculation of the velocity vector, therefore the

potential gradient. A typical method used in unstructured grids to compute

gradients is the least squares method. In this work we follow an approach

proposed by Neel [34].

The starting point to calculate the velocity vector at the cell faces is the

potential function, which is stored at the cell centres of the original mesh.

For each face i, the stencil Si is defined, as shown in figure 3.1. For the

stencil Si, it is possible to fit a k degree polynomial that reconstructs φ and

its gradients:

φ = Ci
0 + Ci

1x + Ci
2y (3.3)

where

• Ci
1 - ui

• Ci
2 - vi

• x - x component of distance from face centre to cell centre

• y - y component of distance from face centre to cell centre

The objective of this formulation is to calculate Ci
1 and Ci

2. A weighted least-

squares formulation can be used. One advantage of performing a weighted

CFD Lab - Uni. of Liverpool 16



3.2 Flux Calculation

least squares fit, is that the system reduces to a set of three equations

and three unknowns (four in 3D), where the coefficients depend only on

geometric values and the weights. The matrix form of the system is:









∑

wj

∑

wjxj

∑

wiyj
∑

wjxj

∑

wjx
2
j

∑

wjxjyj
∑

wjyj

∑

wjxjyj

∑

wjy
2
j

















C0,0

C1,0

C0,1









=









∑

wjφj
∑

wjxjφj
∑

wjyjφj









(3.4)

where wj are the weights of each cell, the index j varies from 1 to m, the total

number of cells in the stencil. Since the matrix consists only of geometric

values and the weights, it can be computed as a pre-processing step. Instead

of storing the matrix itself, it is more efficient to store the inverse. If the

matrix is denoted by B, then its inverse is given by:

B−1 =









b′11 b′12 b′13

b′21 b′22 b′23

b′31 b′32 b′33









(3.5)

Figure 3.1: Stencil to compute gradient at face i
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3.2 Flux Calculation

Hence, the solution is simply given by:

C0,0 = b′11

m
∑

j=1

wjφj + b′12

m
∑

j=1

wjxjφj + b′13

m
∑

j=1

wjyjφj (3.6)

C1,0 = b′21

m
∑

j=1

wjφj + b′22

m
∑

j=1

wjxjφj + b′23

m
∑

j=1

wjyjφj (3.7)

C0,1 = b′31

m
∑

j=1

wjφj + b′32

m
∑

j=1

wjxjφj + b′33

m
∑

j=1

wjyjφj (3.8)

It is also necessary to calculate the derivatives of the velocity components

with respect to all the values of φj within the stencil. The derivatives are

calculated from the least squares reconstruction; with respect to face i and

the stencil Si, the derivatives are given by:

∂ui

∂φj
= b′21wj + b′22wjxj + b′23wjyj (3.9)

∂vi

∂φj
= b′31wj + b′32wjxj + b′33wjyj (3.10)

The density at the face centre is calculated using the face centre values for

the velocity:

ρi =

[

1 +
γ − 1

2
M2

∞

(

1 − u2

i − v2

i

)

]
1

γ−1

(3.11)

The derivative of the density with respect to φ is given by:

∂ρ

∂φj
=

∂ρ

∂ui

∂ui

∂φj
+

∂ρ

∂vi

∂vi

∂φj
(3.12)

with

∂ρ

∂ui

= −(M2

∞ui)

[

1 +
γ − 1

2
M2

∞

(

1 − u2

i − v2

i

)

]
2−γ

1−γ

(3.13)

∂ρ

∂vi
= −(M2

∞vi)

[

1 +
γ − 1

2
M2

∞

(

1 − u2

i − v2

i

)

]
2−γ

1−γ

(3.14)

For the purely subsonic case, the flux can be computed by:

Fi = Aiρi

(

ui~n
i
x + vi~n

i
y

)

(3.15)
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3.3 Boundary and Kutta Condition

where Ai is the face area and the derivatives are given by:

∂Fi

∂φj
= Aiρi

(

∂ui

∂φj
~ni

x +
∂vi

∂φj
~ni

y

)

+ Ai

(

ui~n
i
x + vi~n

i
y

) ∂ρi

∂φj
(3.16)

The residual for each control volume is formed by adding the contributions

of all its faces. If face i is part of cell k, then:

Rk = Rk + σkiFi (3.17)

where

σki =







−1, if ni
x
~i + ni

y
~j is the outer normal

1, if ni
x
~i + ni

y
~j is the inner normal

(3.18)

(3.19)

Finally, the derivative, σki
∂Fi

∂φj

is added into the kth row and jth column of

the Jacobian matrix.

3.3 Boundary and Kutta Condition

Boundary Conditions

In section 2.2, the formulation for the boundary conditions was introduced.

These conditions are enforced by using a layer of halo cells adjacent to the

grid boundaries (both solid surfaces and farfield cells). No calculation is

actually performed on the halo cells; these are just used in order to set

the right values on the boundary edges, given by eq. 2.11-2.12, therefore

it is only necessary to store the halo cell centres. The position of the halo

cells is obtained by mirroring the cell centre of the boundary cell about the

boundary edge. This is illustrated in figure 3.2.

(a) Far Field

The potential function in the halo cells is given by:

φhi = U∞xhi + V∞yhi + Γiθi (3.20)

(b) Solid Surfaces
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3.3 Boundary and Kutta Condition

From the flow tangency condition, eq. 2.12, the following relationship

can be written as:

uin
i
x + vin

i
y = 0 (3.21)

The least squares reconstruction can be re-written to separate out the

contribution of the halo cell, hi:

ui = b′21

∑

j∈Si

j 6=hi

wjφj + b′22

∑

j∈Si

j 6=hi

wjφjxj + b′23

∑

j∈Si

j 6=hi

wjφjyj+

+ b′21whiφhi + b′22whiφhixhi + b′23whiφhiyhi =

= mi
0 + mi

1φhi (3.22)

Similarly

vi = mi
2 + mi

3φhi (3.23)

By applying eq.3.22-3.23 to the boundary condition, eq.3.21, it is pos-

sible to calculate the conditions for the halo cell:

ni
x

(

mi
0 + mi

1φhi

)

+ ni
y

(

mi
2 + mi

3φhi

)

= 0 (3.24)

Eq.3.24 can be rearranged to give:

φhi =
−ni

xm
i
0 − ni

ym
i
2

ni
xm

1
2 + ni

ym
i
3

. (3.25)

(c) Wake Cut

Another type of boundary condition must be enforced across the wake

cells. Figure 3.3 illustrates the wake cut. Cells marked with a k are

actually on different faces, i.e. the top cells correspond to the wake

upper cut and the lower cells correspond to the faces in the lower cut.

Let’s denote faces iu and il as being corresponding faces, with the

same normal: ni
x
~i + ni

y
~j.

Then there are two conditions which must be satisfied across iu and

il:
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3.3 Boundary and Kutta Condition

• continuity of normal velocity component:

ni
xuiu + ni

yviu = ni
xuil + ni

yvil (3.26)

• jump in potential according to the required circulation, Γ:

φu − φl = Γ (3.27)

where φu is the value reconstructed from the stencil Siu and φl

is the value of φ reconstructed from Sil. The stencil Siu features

cells above the cut plus a halo cell below the wake cut. On the

other hand, the stencil Sil contains only cells below the cut plus

a halo cell above the cut. Hence φu and φl are given by:

φu = b
′iu
11

∑

j∈Siu

wjφj + b
′iu
12

∑

j∈Siu

wjφjxj + b
′iu
13

∑

j∈Siu

wjφjyj (3.28)

φl = b
′il
11

∑

j∈Sil

wjφj + b
′il
12

∑

j∈Sil

wjφjxj + b
′il
13

∑

j∈Sil

wjφjyj (3.29)

The two equations that must be satisfied across the faces iu and il

allow the calculation of the halo values for hiu and hil . As before,

extracting out the halo cells contributions to φi, φl, uiu , uil, viu

and vil , it is possible to write the following equations for φhu
and

φhl
as:

ni
x

(

miu
0 + miu

1 φhu

)

+ ni
y

(

miu
2 + miu

3 φhu

)

=

= ni
x

(

mil
0 + mil

1 φhl

)

+ ni
y

(

mil
2 + mil

3 φhl

)

(3.30)

and

(

miu
4 + miu

5 φhu

)

−
(

mil
4 + mil

5 φhl

)

= −Γ (3.31)

Eq.3.30-3.31 can be written in matrix form as:

H

[

φhu

φhl

]

= ~g (3.32)
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3.3 Boundary and Kutta Condition

then:
[

φhu

φhl

]

= H−1~g (3.33)

where:

H =

[

ni
xm

iu
1 + ni

ym
iu
3 −

(

ni
xm

il
1 + ni

ym
il
3

)

miu
5 −mil

5

]

(3.34)

~g =

[

−
(

ni
xm

iu
0 + ni

ym
iu
2

)

+ ni
xm

il
0 + ni

ym
il
2

−miu
4 + mil

4 − Γ

]

(3.35)

Finally, it is possible to obtain:

φhu
= H−1

11

[

−
(

ni
xm

iu
0 + ni

ym
iu
2

)

+
(

ni
xm

il
0 + ni

ym
il
2

)]

+ H−1

12

(

−miu
4 + mil

4 − Γ
)

(3.36)

φhl
= H−1

21

[

−
(

ni
xm

iu
0 + ni

ym
iu
2

)

+
(

ni
xm

il
0 + ni

ym
il
2

)]

+ H−1

22

(

−miu
4 + mil

4 − Γ
)

(3.37)

Figure 3.2: Halo Cell

Kutta Condition

As explained in section 2.3, in order to compute aerodynamic loads, it is

necessary to enforce the Kutta condition at the trailing edge of the aerofoil,

up to the farfield. In this work, this process is linked with the grid generated

to solve a particular problem. Since unstructured grids are being used, it

is possible to generate or find, a sequence of edges that link the aerofoil
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3.3 Boundary and Kutta Condition

trailing edge to the farfield. This sequence represents the cut due to the

double value of θ and it is referred to as Kutta Line. The only care taken

in constructing this artifice, is to ensure that each cell is only updated once

by this process. Figure 3.3 illustrates the Kutta Line and the cells tagged

for updating. The circulation is calculated at the trailing edge, by splitting

the calculation in contributions from the upper and lower surfaces. Hence,

to reconstruct φ at the trailing edge, two stencils are required, one for the

upper surface and another for the lower surface, Steu and Stel. These stencils

should be upstream of the trailing edge, see figure 3.3.

The values for φu
te and φl

te can be reconstructed by using the least-squares

formulation and the corresponding stencils, Steu and Stel:

φu
te = b

′teu
11

∑

j∈Steu

wjφj + b
′teu
12

∑

j∈Steu

wjφjxj + b
′teu
13

∑

j∈Steu

wjφjyj (3.38)

φl
te = b

′tel
11

∑

j∈Stel

wjφj + b
′teu
12

∑

j∈Stel

wjφjxj + b
′tel
13

∑

j∈Stel

wjφjyj (3.39)

Then, the circulation is given by:

Γ = −
(

φu
te − φl

te

)

(3.40)

Figure 3.3: Kutta Line
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3.3 Boundary and Kutta Condition

Note that Γ depends on the values calculated both faces forming the trailing

edge, as showed in figure 3.3, i.e. in either of the stencils Steu and Stel.

The far field and wake halo cells depend on the value of Γ, and hence

on the cells in Steu and Stel.

Modified Jacobians for Boundary Conditions

Now, the derivatives added into the Jacobian matrix include those with

respect to the halo cells values of the potential. The boundary conditions

have related these halo cells to internal cell values and to the circulation.

In general it is possible to write:

φhi
= φhi

(φk, φp) for k ∈ Sh
i , p ∈

(

Steu ∪ Stel
)

(3.41)

where Sh
i is the stencil for halo cell hi.

Hence:

∂Fi

∂φj
=

∂Fi

∂φhi

∂φhi

∂φj
+

∂Fi

∂φhi

∂φhi

∂φk
, for j ∈ Sh

i , for k ∈
(

Steu ∪ Stel
)

(3.42)

with:

∂Fi

∂φhi

∂φhi

∂φk
=

∂Fi

∂φhi

∂φhi

∂Γ

∂Γ

∂φk
, for k ∈

(

Steu ∪ Stel
)

(3.43)

To complete the formulation, it is still necessary to define
∂φhi

∂φj
for the 3

types of boundary conditions, and
∂φhi

∂Γ
,

∂Γ

∂φk
.

(a) Far field:
∂φhi

∂Γ
= θhi

(3.44)

where θhi
is defined in section 2.3.

(b) Solid Surface:

∂φhi

∂φj
= −

ni
x

ni
xm

i
1 + ni

ym
i
3

∂mi
0

∂φj
−

ni
y

ni
xm

i
1 + ni

ym
i
3

∂mi
2

∂φj
(3.45)

CFD Lab - Uni. of Liverpool 24



3.3 Boundary and Kutta Condition

where:

∂mi
0

∂φj
= b′21wj + b′22wjxj + b′23wjyj (3.46)

∂mi
2

∂φj
= b′31wj + b′32wjxj + b′33wjyj (3.47)

Sh
i is obtained by excluding hi from Si.

Finally:
∂φhi

∂Γ
= 0 (3.48)

(c) Wake Cut:

∂φhiu

∂φj

= H−1

11

[

−ni
x

miu
0

∂φj

−−ni
y

miu
2

∂φj

+ ni
x

mil
0

∂φj

+ ni
y

mil
2

∂φj

]

(3.49)

∂φhil

∂φj
= H−1

21

[

−ni
x

miu
0

∂φj
−−ni

y

miu
2

∂φj
+ ni

x

mil
0

∂φj
+ ni

y

mil
2

∂φj

]

(3.50)

Here:

∂miu
0

∂φj

= b
′iu
21 wj + b

′iu
22 wjxj + b

′iu
23 wjyj

∂miu
2

∂φj
= b

′iu
31 wj + b

′iu
32 wjxj + b

′iu
33 wjyj



















, for j ∈ Siu , j 6= giu (3.51)

similarly for
∂mil

0

∂φj
,

∂mil
2

∂φj

also:

∂φhiu

∂Γ
= −H−1

12 (3.52)

∂φhil

∂Γ
= −H−1

23 (3.53)

(d) Circulation

∂Γ

∂φj

= b
′teu
11 wj + b

′teu
12 wjxj + b

′teu
13 wjyj, for j ∈ Steu (3.54)

∂Γ

∂φj

= b
′tel
11 wj + b

′tel
12 wjxj + b

′tel
13 wjyj, for j ∈ Stel (3.55)
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3.3 Boundary and Kutta Condition

3.3.1 Linear System

The method described above is used to set up the following linear system:

∂R

∂Φ
∆Φ = −Rn (3.56)

∆Φ = Φn+1 − Φn (3.57)

Φ and R are vectors containing the potential function and the residual,

respectively, while n represents the current time level. These vectors are

formed by using the method described above. The system is solved using

GMRES with an ILUΦ preconditioner. The package PETSc is used to

perform these operations, [36].

CFD Lab - Uni. of Liverpool 26



Chapter 4

Results

4.1 2D NACA0012 - Subsonic Case

As mentioned before, the validity of full-potential methods is limited to

Mach number less than 1.3. The first test case used to validate the method

presented in this work, was the NACA 0012 aerofoil in subsonic flow, M=0.2.

The Euler solutions were obtained in a structured grid, finite-volume

code. The grid used is showed in Figure 4.1and consists of 4096 cells and

4323 points. The Full Potential solutions were obtained in an unstructured

grid, as shown in Figure 4.2, and the grid consists of 1510 points and 2792.

The surface resolution in both cases is identical.
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(b) Aerofoil Detail

Figure 4.1: Euler Structured Grid

Figure 4.3 shows the CP distribution at four different incidence angles:

0◦, 1◦, 3◦, 6◦, while Figure 4.4 show the iso-Mach contours at 0◦ and 6◦

incidence, respectively.
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4.1 2D NACA0012 - Subsonic Case
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Figure 4.2: Full-Potential Unstructured Grid

Inspection of both types of plots, shows excellent agreement with the es-

tablish Euler solver. The pressure coefficient plots show a good agreement

in predicting both stagnation points and suction peaks. The iso-Mach con-

tours also reveal identical flow features between both solver methodologies.

The efficiency of this method is illustrated by the convergence plots, shown

in figure 4.5. The Full-Potential method reaches a converged solution in

38 implicit steps. The initial results are encouraging and work is being

carried out to extend the Full Potential method to deal with compressibility

features, such as shock-waves.
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4.1 2D NACA0012 - Subsonic Case

(a) α = 0◦ (b) α = 1◦

(c) α = 3◦ (d) α = 6◦

Figure 4.3: NACA 0012 CP Distribution - M=0.2
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4.1 2D NACA0012 - Subsonic Case
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(c) Full Potential - α = 6◦
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(d) Euler - α = 6◦

Figure 4.4: NACA 0012 Iso-Mach Contours - M=0.2
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Figure 4.5: NACA 0012 Convergence History
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Appendix A

Grid Generation

In this chapter a step by step grid generation procedure is described. The

process for an aerofoil is described first followed by the corresponding ap-

proach in 3D.

2D Grid Generation

The first step to start generating grids using ICEM is to start the software

and starting a new project. To launch ICEM open a terminal window and

setup the correct ICEM version by typing:

> source /software/ro/ICEMCFD11SP1/setup

> icemcfd

With the ICEM GUI initiated, a new project can initiated by making:

File > New Project

A suitable name for the project is requested and this will be the reference

used to define several output files created by ICEM.

Usually, for a 2D section, the geometry is in the form of a list of points.

The first step in generating the grid is inputing all the points that define

the geometry. If the points are defined in a file, it is required that the first

line includes 2 parameters, i.e. a line with two integers, that correspond

to the number of points for each curve and the number of curves for each

surfaces. To load the file use the main menu:

File > Import Geometry > Formatted Point Data
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Once the points are loaded, they should appear similar to the example

in Figure A.1. To create the aerofoil shape, it is necessary to form a close

surface by creating a B-Spline by joining all the points; these commands

can be found in Geometry toolbar:

Geometry > Create/Modify Curve > From points

For a typical aerofoil, this will consist of two splines, corresponding to

the upper and lower surfaces. With the geometry created, it is necessary

(a) (b)

Figure A.1: Grid Overview

to define the outer boundaries of the flowfield. In this example, the up-

stream boundary will be formed by a semi-circle and the remainder of the

outer boundaries will be defined by a rectangle. This shape is not a require-

ment and can/should be adapted to the characteristics of the problem. The

starting point is to create 8 new points. The coordinates are shown in Table

A.1. The actual boundary is formed by connecting each pair of points with

the exception of the semi-circle, which is generated by the specific tool for

creating arc with 3 points. The ICEM GUI output is illustrated in Figure

A.2.
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X Y
Point 1 40.0 40.0
Point 2 40.0 0.0
Point 3 40.0 -40.0
Point 4 5.0 -40.0
Point 5 -5.0 -40.0
Point 6 -45.0 0.0
Point 7 -5.0 40.0
Point 8 5.0 40.0

Table A.1: Outer Boundary Points

(a) (b)

Figure A.2: Farfield Definition

In order to generate a pure 2D grid in ICEM, what is actually done

is generating a surface mesh. Hence the next step is to define the surfaces

where the grid will actually be constructed. In general, geometry and topol-

ogy definition follow a bottom-up approach, i.e. first points are generated,

then curves, then surfaces and from the surfaces, volumes can be defined.

In this example, the aim is to generate a smooth unstructured grid. To

facilitate this task, extra surfaces and lines are used of what would be abso-

lutely necessary to generate a 2D grid. In the end 6 surfaces are generated.

The final surfaces and lines used are illustrated in Figure A.3 In this exam-

ple, surfaces are defined by sets of 4 connected curves. When selecting this

option from the Geometry toolbar, the smallest tolerance aloud should be

used.

Geometry > Create/Modify Surface > Simple Surface
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(a) (b)

Figure A.3: Surface Lines

Repeat the process for each set of 4 curves, to generate the 6 surfaces.

Figure A.4 shows the first surface created, where the selected curves are

highlighted in yellow. Figure A.5shows the representation of the surfaces

in ICEM. To ensure an adequate cell size distribution across the grid, it

is possible to assign node distributions along selected curves. The aerofoil

surface boundary is divided into four curves. The two leading edge curves

are assigned 55 nodes, with initial and final spacings of 0.005 and 0.01

respectively. The two downstream parts of the aerofoil are discretise with

40 nodes with initial and final spacings of 0.01. Hyperbolic laws are used

to distribute the nodes and achieving the correct spacings. The result is

presented in Figure A.6 and Figure A.7. The same process is applied to the

remainder of the curves. Particular attention is given to the regions close

to the aerofoil to ensure the node spacing is consistent between adjacent

curves. At this stage, is possible to generate the grid. ICEM offers several

alternatives to generate the final grid. The most robust generator is referred

to as Octree method. To apply this method, in the Global Mesh Paramenter

menu, select Patch Independent as the mesh method. On the other hand

if instead, the user selects Patch Dependent and applies the option to keep

the option Respect line elements ON, ICEM will respect the curve spacings

and in general produce a more smooth grid. The differences are illustrated

in Figure A.8 and Figure A.9. Once all parameters are set, the command

to generate the grid is found in the Compute Mesh menu, for 2D cases the

Surface Mesh Only option must be selected.
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Figure A.4: Creating Surfaces

(a) (b)

Figure A.5: Grid Surfaces
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Figure A.6: Aerofoil Node Distribution

Figure A.7: Curve Node Distribution
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(a)

(b)

Figure A.8: Grid Method Comparison - Grid General View
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(a)

(b)

Figure A.9: Grid Method Comparison - Aerofoil Detail View
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Once the grid is generated it is possible to check and improve the qual-

ity of the elements. Several other operations are also available such as

refine/coarsen the whole or parts of the grid. There are several measures

to improve the quality of a given grid. The main options are located in the

Edit Mesh menu.

• Repair Mesh

− > Remesh Bad Elements

− > Smooth Surface

• Smooth Elements

• Repair Mesh

− > Edge Swap

− > (Split Tree Elements)

The results of applying these techniques are shown in Figure A.10. The

quality improvement is marginal, but this is mainly due to the simplicity of

the problem. Nevertheless, as the histograms in both figures indicate, there

have been clear improvements. For more complex geometries and 3D grids

this techniques are fundamental to obtain good results.

CFD Lab - Uni. of Liverpool 39



(a)

(b)

Figure A.10: Grid Quality Improvement: a) Initial Grid; b) Final Grid
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3D Grid Generation

As expected, the situation is more complex for 3D grids. The example ex-

plained here follows one of the tutorials from ICEM. The tutorials included

in the software are very useful for the user to become familiar with the

several options available. However, in this particular example, the results

from the tutorial are not suitable for the FP method previously described.

Furthermore, the resultant grid would not consist of tetrahedral exclusively.

In general it is expected for a 3D geometry to be created by some CAD

package and then imported into ICEM. In this case the geometry is available

from the tutorial directories installed with the software. The geometry is

loaded by using the icon corresponding to open geometry file and follow the

path to the tutorial directory:

.../v110/docu/Tutorials/CFD_Tutorial_Files>FinConfig

The first task when importing geometry components into ICEM, is to check

for any errors from the geometry native file. ICEM provides several options

under the Geometry > Repair Geometry menu

The geometry file already includes most of the surfaces that are necessary,

however since the objective is to obtain a grid for the particular FP method

described in previous sections, it is require to add the surface that is going

to be used for the enforcement of the Kutta condition. To achieve this, the

trailing edge curves and surface are split in two, the new points dividing the

trailing edge curves are projected into the rear surface to allow setting up

new for curves connecting each pair of new points. Figure A.11 illustrates

these steps.

In order to achieve a well balanced and as regular as possible grid, at

this stage it is possible to define the grid spacing for the curves that make

up the geometry. When constructing the final grid ICEM will try to match

these spacings wherever possible. By turning on the node spacing it is pos-

sible to visualise the several distributions. In Figure A.12 6-10 uniformely

distributed points were used in the farfield edges. For the curves created

for the kutta surface, an hyperbolic function is used to distribute 30 points

with a bias towards the fin. The user should ensure the clustering towards
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Figure A.11: Generating the Kutta Plane
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Figure A.12: Curve Spacings

the wing is adequate and smooth. For this case, the surface were already

defined by the CAD file. At this stage, it is necessary to discriminate them

by creating corresponding parts. In this example, the different surfaces will

correspond to the different parts. New parts are created from the Display

Tree by right-click on Parts > Create Part. In this case the following parts

were created:

• fin upper surface → suction

• fin lower surface → pressure

• leading edge surface → le

• upper trailing edge surface → te-upper

• lower trailing edge surface → te-lower

• fin tip → tip

• kutta surface → kutta

• wall surface → symm

• outer boundaries → farfield
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Figure A.13: Parts Creation

Figure A.13 shows a detail view of the fin tip and leading edge. One key

difference between 2D and 3D grid in ICEM, is the requirement to define

the material point of the grid. This correspond to the actual fluid domain of

the problem and differentiates this region from any interior spaces created

by the geometry. The material point must be place within the volume to be

meshed, that is achieve by selecting two points, e.g.: fin tip and any corner

from the farfield, in the Create Body menu, i.e.:

Geometry > Create Body > Material Point

The actual mesh generation procedure, starts by defining the mesh global

sizes. For this case the value of 32 is used for maximum tetrahedral size.

Note Figure A.14 and how the actual size is overlayed on the geometry.

This parameter is selected from the Mesh toolbar:

Mesh > Set Global Mesh Size > Global Mesh Size

Following the definition of the global sizes, it is possible to define the element

sizes for each surface/part, with the exception of the kutta plane. The

maximum size for each surface much ensure the grid resolution is sufficiently

true to the original geometry. Hence, regions of high curvature will require

smaller elements than larger flat areas. As for the previous parameter, this

parameter is edited from the Mesh toolbar:
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Figure A.14: Setting Elements Global Maximum Size

Mesh > Surface Mesh Setup > Select surface

With the surface element sizes assigned, it is possible to compute the mesh.

In this case it is necessary to select Volume Mesh to mesh the complete

domain and not just the surfaces:

Mesh > Compute Mesh > Volume Mesh > Tetra/Mixed > Robust (Octree)

Figure illustrates the surface grid at this stage. To make the volume grid

consistent with the kutta plane, it is necessary to return to the Surface

Mesh menu. By selecting the kutta plane surface and toggle on the Remesh

Selected Surfaces button ON, when the new surface grid, ICEM will ask if

the user wishes to make the surface grid consistent with the existing volume

grid. If the kutta plane surface grid scales are consistent with the volume

mesh, this should result in a valid grid. Figure A.15 shows the ICEM output

during this procedure, while Figure A.16 shows the final grid:
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Figure A.15: Meshing the kutta plane

Figure A.16: Final Surface Grid including kutta plane
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Appendix B

Grid Converter

Unstructured grids require to carry the mesh connectivity information ex-

plicitly. This can be done in many different ways. ICEM offers several types

of output for the connectivity data structure. The FP solver described in

the previous chapters, uses a face base structure. It assumes two lists: one

containing the grid nodes cartesian coordinates; the second list contains the

connectivity information for each face - adjacent cells and forming points.

Table B.1 and Figure B.1 describe the face connectivity.

Face Left Cell Right Cell Point 1 Point 2 Point 3
. . . . . . . . . . . . . . . . . .
i Cell 1 Cell 2 A B C

. . . . . . . . . . . . . . . . . .

Table B.1: Face data list

Besides interpreting the grid connectivity, the flow solver requires identi-

fication of the several boundary conditions: surface faces, farfield and kutta

plane. ICEM offers several types of output, from general formats such as

STL, to specific solvers such as Fluent. After analysing several output for-

mats, it was decided to use the FIDAP solver output structure. This ASCII

format, outputs the grid node list, followed by a list of pointers for the nodes

of each cell and a list of pointers for the nodes of each surface of each part.

This is why it is vital and required for user to create specific parts in ICEM.

The grid converter sequence of operations is illustrated in Figure B.2: In
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Figure B.1: Face Base Data Structure

Figure B.2: Grid Converter Fluxo-Gram
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task 4 of the fluxogram, the program shows the part name and requires the

user to input the correspondent boundary type, at this stage the following

conditions are available:

1. Surface

2. Farfield

3. Kutta Plane

4. Symmetry

5. Other

The solver input file is generated at the last step. The grid faces are ordered

starting with the surface faces, this is followed by the farfield faces, Kutta

Plane, Symmetry and finally all interior faces.
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